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A

 

bout this guide

 

T

 

his guide explains how to use Adobe

 

®

 

 R

 

eader

 

®

 

 f

 

or Palm OS

 

®

 

,

 

 version 3.0 software to 
transfer and view Portable Document Format (PDF) files on your Palm OS device. 

To get the most out of Adobe Reader for Palm OS, you should have a working knowledge 
of Palm OS functionality and conventions. For help with issues related to using your 
handheld device, please see its documentation.

Adobe Reader for Palm OS has two components: the desktop program installed on your 
desktop computer, and the reader installed on your Palm OS device.

 

A

 

bout Adobe PDF

 

T

 

he Adobe Portable Document Format (PDF) is standard for electronic document distri-
bution worldwide. PDF documents retain the appearance of your original documents, so 
you don’t need to worry about losing document quality. Adobe Reader for Palm OS lets 
you view and navigate PDF files on a Palm OS device, virtually anytime, anywhere. Adobe 
PDF and Adobe Reader for Palm OS are cross-platform network publishing solutions. 

 

A

 

bout tagged PDF

 

T

 

o properly display a PDF document on your handheld device screen, Adobe Reader for 
Palm OS requires that PDF files be tagged. Tagged PDF files contain structural information 
about the elements and layout of a page. Adobe Reader for Palm OS can generate this 
structural information to the best of the desktop application’s ability during the transfer 
process, but for best results, it is recommended that authors and creators of PDF 
documents use Adobe Acrobat

 

®

 

 6.0 P

 

rofessional or Adobe Acrobat 6.0 Standard to create 
tagged PDF files directly from the source files. PDF files may have a somewhat larger file 
size after they are tagged. 

You can create tagged Adobe PDF files automatically when you use Acrobat PDFMaker 6.0 
to create Adobe PDF files from within Microsoft Word, Excel, or PowerPoint.

 

S

 

etting preferences on your desktop computer

 

A

 

dobe Reader for Palm OS has preferences that you set on your desktop computer. You 
can choose the way images and colors are interpreted for viewing on a Palm OS device 
and set HotSync® Preferences to decide where files are transferred. 



 

S

 

ettings that affect your handheld device are shown in the picture of a handheld device in 
the Preferences dialog box. Warnings appear if you have selected incompatible settings 
for your device. 

 

P

 

references dialog box

 

S

 

etting preferences on your Palm OS device

 

In addition t

 

o the preferences on your desktop computer, there are preferences you can 
set on your handheld device. 

 

T

 

o set preferences:

1   

 

T

 

ap the Adobe Reader menu icon.

 

2

 

  

 

T

 

ap View > Preferences, and then choose from the following options:

 

•

 

 

 

S

 

how Splash Screen at Startup to display a screen with information about your version 
of Adobe Reader for Palm OS each time you start the application. This option is selected 
by default.

 

•

 

 

 

T

 

ap Screen for Prev or Next to navigate a document by tapping the screen. Selecting 
the horizontal or the vertical split screen moves the page when you tap it. You must 
also choose whether you want to move forward and backward a screen at a time, or a 
page at a time by selecting the appropriate option. 

 

•

 

 

 

Sc

 

an for All Comments on Open If Doc Has Less Than ___ Pages to scan each document 
for comments when it is opened, provided the number of pages does not exceed the 
specified limit (default limit is four pages). Comments and descriptions appear in the 
Comments view.

 

•

 

 

 

R

 

emember Last Page Viewed to remember the document and view when you exit the 
application. The next time you start the application you’ll see the same document just 
as you left it. By default this option is selected.



 

•

 

 

 

S

 

how “Tap and Hold” Message to toggle the display of the Tap and Hold graphic to view 
it in Full Size message. Select this option to display or hide the message.

 

G

 

etting settings from your Palm OS device

 

A

 

n easy way to get the best settings for files that you transfer to your handheld device is to 
click Get Best Settings in the Preferences dialog box on your desktop computer. 

You can make changes to the settings received from your handheld device; however, 
changing some settings may cause problems. For example, if you choose Thousands of 
Colors for a 256 color device, the images don’t appear.

 

T

 

o get the best settings from your Palm OS device:

1   

 

M

 

ake sure that your handheld device is in its cradle and connected to your computer.

 

2

 

  

 

On y

 

our desktop computer, start Adobe Reader for Palm OS.

 

3

 

  

 

C

 

lick Preferences to open the Preferences dialog box.

 

4

 

  

 

C

 

lick Get Best Settings.

 

5

 

  

 

P

 

ress the HotSync button  on the cradle.

 

S

 

pecifying image settings

 

W

 

hen transferring PDF files to your handheld device, you can select the Full size option to 
preserve the images at full-size in the transferred document. If you select Shrink to screen 
width, all images are reduced to the width of the device screen, and displayed in the 
document page flow. You can also elect to remove the images from a PDF file.

Adobe Reader for Palm OS, version 3.0 also supports color handheld devices. This means 
that the color in images is retained when a PDF file is transferred to a color handheld 
device. You can remove color from images if you like to reduce the file size. 

 

T

 

o set image preferences:

1   

 

On y

 

our desktop computer, start Adobe Reader for Palm OS.

 

2

 

  

 

C

 

lick Preferences to open the Preferences dialog box.

 

3

 

  

 

T

 

o set image preferences, select one of the following:

 

•

 

 

 

F

 

ull Size to keep full-size images available for viewing on Palm OS devices. Magnifi-
cation of the images is adjusted when viewed on a handheld device. Tap and Hold 
Graphic to View It in Full Size appears above the graphics

 

.

 

 Documents with full size 
images have larger file sizes.

 

•

 

 

 

S

 

hrink to Screen Width to reduce images to the width of the handheld device screen.

 

•

 

 

 

N

 

o Images to delete all images from the converted file. Images aren’t removed from the 
original document. The converted file size is smaller without images.

 

4

 

  

 

T

 

o set the color preferences for images, select one of the following:

 

•

 

 

 

R

 

etain Color in Images to keep all color elements in a PDF file.

 

•

 

 

 

256 C

 

olors to optimize images for quick display on the handheld device. Image quality 
might be degraded, but the PDF file size is smaller.

 

•

 

 

 

T

 

housands of Colors to optimize images for high-quality display. Images load slower 
and the PDF file might be larger.

 

5

 

  

 

C

 

lick OK.



 

S

 

etting HotSync preferences

 

Y

 

ou can transfer PDF files to an expansion card if you have one installed in your Palm OS 
device. This option is available after the first time you perform a HotSync operation.

 

T

 

o transfer PDF files to an expansion card:

1   

 

On y

 

our desktop computer, start Adobe Reader for Palm OS.

 

2

 

  

 

C

 

lick Preferences, and then select your expansion card from the Transfer Files To pop-up 
menu at the bottom of the screen.

 

N

 

ote

 

: If your expansion card is not listed in the Transfer Files To menu, make sure that the 
card is installed properly and that your device is cradled properly. Invoke the Get Best 
Settings screen, perform a HotSync operation, and then change the preferences from main 
memory to the expansion card.

 

T

 

ransferring PDF files

 

B

 

efore you can view PDF documents on your Palm OS device, you need to transfer them 
from your desktop computer to your handheld device. The Adobe Reader for Palm OS 
dialog box lets you select and transfer PDF files to your handheld device. Performing a 
HotSync operation downloads the files. The files remain in the transfer list until you 
activate HotSync from your handheld device.

 

T

 

o transfer PDF files to your Palm OS device:

1   

 

On y

 

our desktop computer, start Adobe Reader for Palm OS.

 

2

 

  

 

C

 

hoose the name from the User menu. The transfer list displays any pending files previ-
ously selected by that user. 

 

A

 

dobe PDF files pending transfer



 

3

 

  

 

C

 

lick Add, browse to the files you want to transfer, and then click Open. 

 

N

 

ote:

 

 If the PDF file that you want to transfer is Open-password protected, the Enter 
Password dialog box appears. Enter the password for the PDF file in the User Password text 
box, and the PDF file is added to the transfer list.

 

4

 

  

 

I

 

f a PDF file is not tagged, the About Tagged PDF dialog box appears. Click OK to allow 
Adobe Reader for Palm OS to add the necessary tags.

 Deselect Warn Me Before Adapting Untagged Adobe PDF Files in the Preferences 
dialog box if you don’t want to receive this warning in the future. 

 

5

 

  

 

W

 

hen all of the files that you want to transfer have been added to the transfer list, 
perform a HotSync operation. 

 

T

 

o drag and drop PDF files to transfer:

1   

 

On y

 

our desktop computer, locate and select the files that you want to transfer.

 

2

 

  

 

D

 

o one of the following:

 

•

 

 

 

I

 

f Adobe Reader for Palm OS is open, drag the files into the desktop window.

 

•

 

 

 

(

 

Windows Only) If Adobe Reader for Palm OS isn’t open, drag the files onto the Adobe 
Reader for Palm OS icon on the desktop.

 

3

 

  

 

I

 

f a PDF file is not tagged, the About Tagged PDF dialog box appears. Click OK to allow 
Adobe Reader for Palm OS to add the necessary tags. If you do not want tags added, the 
file cannot be added to the transfer list or opened on the handheld device.

 

4

 

  

 

W

 

hen all of the files that you want to transfer have been added to the transfer list, 
perform a HotSync operation. 

 

T

 

ransferring PDF files using the Send to Palm plug-in

 

T

 

he Send to Palm plug-in allows you to add a PDF file to the transfer list directly from 
Adobe Acrobat 6.0. The Send to Palm plug-in automatically installs with Adobe Reader for 
Palm OS if Acrobat 6.0 or Adobe Reader 6.0 is installed. 

 In Windows®, you can also right-click a filename to use the plug-in.

 

T

 

o use the Send to Palm plug-in from Acrobat:

1   

 

In A

 

crobat, open the PDF file that you want to transfer to your handheld device.

 

2

 

  

 

C

 

hoose File > Send to Palm.

 

N

 

ote:

 

 The Send to Palm command doesn’t appear if the Send to Palm plug-in isn’t 
installed.

 

3

 

  

 

T

 

he PDF file is processed and added to the transfer list.

 

T

 

o use the Send to Palm plug-in by right-clicking (Windows only):

1   

 

R

 

ight-click the PDF file that you want to transfer to your handheld device.

 

2

 

  

 

C

 

hoose Send to Palm from the context menu.

 

3

 

  

 

W

 

hen all of the files that you want to transfer have been added to the transfer list, 
perform a HotSync operation. 

 

N

 

ote

 

: If a PDF file is not tagged, the About Tagged PDF dialog box appears. Click OK to 
allow Adobe Reader for Palm OS to add the necessary tags.



 

Remo

 

ving PDF files from the transfer list

 

Y

 

ou can easily remove PDF files from the transfer list. Removing PDF files does not affect 
the original file but removes the tagged file from your desktop computer.

 

T

 

o remove PDF files from the transfer list:

 

S

 

elect the files, and click Remove.

 

U

 

sing the file list

 

T

 

he file list is a scrollable list of all the Adobe PDF files on your Palm OS device. The list also 
displays the file size of each document. The file list appears the first time you open Adobe 
Reader for Palm OS on your handheld device. 

You can scroll through the file list view by dragging the scroll bar, or you can use the scroll 
up and scroll down buttons on the handheld device. If your device has a jog dial, you can 
use it to scroll through the file list. If you press and scroll up or down, the entire file list 
moves. This way you can view all the files, even if the list is long. 

 

T

 

o sort documents:

1   

 

I

 

f a PDF file is open, tap the file list icon  to display the file list.

 

2

 

  

 

T

 

ap the Adobe Reader menu, and then choose Sort by Name, or Sort by Size. The 
defaults are from “a” to “z,” and smallest file size to largest. Selecting the same option twice 
inverts the list. 

To delete a document from the file list:

1   Select the document that you want to delete.

2    Tap Delete. 

 To remove all documents at once, tap All, and then tap Delete.

Opening and closing documents
You will usually open a document from the file list view, unless you have selected to retain 
the document view on close. You can close the current document and open a new 
document using the Document menu. Only one document can be open at a time.

Note: If your Palm OS device has a secondary storage card and you wish to access PDF 
documents from the card, make sure that your PDF documents reside in the default 
directory meant for .pdb files (on the Palm OS device). For example, the default directory 
for .pdb files on a Palm m500 or Palm m505 is /Palm/Launcher, or on a Sony Clie PEG S300 
it’s /Palm/Programs/MSFiles. The Adobe Reader software looks in this directory and all its 
subdirectories for PDF documents.

To open a document from the file list:

Tap the filename in the file list view.

To open a password protected file:

Enter the password in the dialog box provided. 



To close the current document and return to file list view:

Tap the file list icon .

To close the current document and open a different one:

1   Tap the Menu icon on your handheld device (not in the display screen), and then tap 
Open on the Document menu.

2   Tap the filename of the document you want to open. 

To cancel file and page open actions:

Tap the screen as a file or page opens.

Working with documents
Once you have transferred a PDF file to your Palm OS device, you can work with it much 
the same way you do on your desktop computer. You can scroll through each page and 
search in a document.

Scrolling through documents
You can see more of a PDF file by scrolling or dragging. This is similar to moving a sheet of 
paper around on a desktop. You can also set preferences to move the document by 
tapping the screen.

To use the scroll bar:

Do one of the following:

•  Tap the top or bottom arrow at the ends of the scroll bar.

•  Tap and hold an arrow to scroll continuously. 

•  Drag the handle in the middle of the scroll bar to move quickly up or down through the 
page. 

•  Tap above or below the handle to move up or down one screen at a time.

•  Press the scroll buttons on your handheld device.

•  Scroll with the jog dial or 5-way navigation buttons.

If you tap the scroll arrows when you reach the top or bottom of a page, you go to the next 
or previous page.

To tap-drag:

Tap anywhere in the screen, and drag to move the page up or down. 

To screen tap:

Page up or down by tapping anywhere in the screen. Screen tapping is determined by the 
preferences that you set.

Note: Tapping the screen while the document is loading closes the document and returns 
you to the file list. Tapping the screen while moving between pages returns you to the 
previous view.

To go to the next or previous page:

Tap the next page  or previous page  icon in the tool bar.



To move forward or backward in the document:

Tap or drag the document position bar  to move to the corresponding page. 
The current page number appears as you go forward or backward.

To move forward or backward in your view history:

1   Tap the Menu icon on your handheld device (not in the display screen).

2   Tap View, and then tap Back or Forward.

This moves you to the last view displayed on-screen and returns you to your current view 
respectively.

To go to specific pages:

Do one of the following:

•  Tap the Menu icon on your handheld device (not in the display screen), tap View, tap Go 
to Page, and then enter a page number, or tap Beginning or End.

•  Tap the current page indicator, and enter a page number.

•  Enter a page number, and click Go.

•  If your handheld device has a jog dial, press and scroll the jog dial up or down to go to 
the beginning or end of the document.

 You can also use Graffiti® software to write the page number in the numeric Graffiti 
area.

Viewing PDF files in Full Screen mode
To maximize the viewing area, you can view documents in Full Screen mode. When this 
option is selected, the navigation tools at the bottom of the screen and the scroll bar at 
the right of the screen are hidden. Text automatically reflows to fill the larger display area. 
The tool bar and scroll bar can be temporarily restored without exiting Full Screen mode.

To turn Full Screen mode on and off:

1   Tap the Menu icon on your handheld device (not in the display screen).

2   Tap View, and then tap Full Screen. 

3   Repeat steps one and two to turn Full Screen off. 

To temporarily restore navigational tools while in Full Screen mode:

Tap in the right hand margin (where the scroll bar normally is). The scroll bar and 
navigation tools are temporarily displayed at the bottom of the document without 
reflowing the page to fit the reduced display area. Use any of the navigation tools as you 
would in normal viewing mode. After an action is completed, the navigational tools 
disappear. 

 While you touch the screen, the tools remain visible. If no action is taken within one to 
two seconds, the tools disappear.



Changing the text display
The default text display on your Palm OS device is Styled Text, which retains the original 
look of the source PDF file, including text size, style, and alignment. You can change the 
text display to large text, bold text, or large and bold text.

Note: Not all text attributes are reproducible, and text display size is device dependent.

To change the text display:

1   Tap the Menu icon on your handheld device. 

2   Tap View, and then tap Styled Text, Large Text, or Bold Text. When you choose a text 
display option, the appearance of the text changes immediately. 

Viewing images in documents
When a PDF file includes images, the images may be full-size or reduced to fit the width of 
your handheld screen. If images are scalable, Tap and Hold Graphic to View It in Full Size or 
a small triangle  appears above the image. You can also choose to display or hide the 
images in a document.

To show or hide images:

Tap the Menu icon on your handheld device (not in the display screen), and then tap Hide 
Images, or Show Images in the Document menu.

To view full-size images:

1   Tap and hold on the image. The image appears at full size. 

2   Scroll to view the image:

•  Use the vertical and horizontal scroll bars to adjust the visible portion of the image. You 
may also tap an area in the Navigator  below the image to jump to a different part 
of the image. The small rectangle corresponds to a location in the image. You can also 
use the buttons on your handheld device.

•  If your handheld device has a jog dial, use the jog dial to move the image up or down.

3   Magnify or reduce the view:

•  Tap the zoom buttons .

•  If your handheld device has a jog dial, press the jog dial, and scroll up to zoom out or 
scroll down to zoom in.

•  If your handheld device has 5-way navigation buttons, use the buttons to move the 
image up, down, left, or right.

4   Close the full-size view:

•   Tap Done.

•  If your handheld device has a jog dial, click the jog dial to return to the original 
document view.

Note: You may also move the image screen by screen by tapping the area of the screen 
corresponding to the direction you would like to move the image. Dragging will scroll the 
graphic in the corresponding direction pixel by pixel.



Selecting text
You can select text in a PDF file, copy it, and paste it into a document in another appli-
cation. This is good for moving data to applications such as a memo pad, e-mail, and to do 
list. You can select text only from the current page.

To select text:

1   Drag horizontally over text to start the selection. You can then drag vertically to select 
more than one line.

2   Tap the Menu icon on your handheld device (not in the display screen), and then tap 
Copy in the Document menu.

3   To cancel the selection, tap anywhere in the document.

 Tap and hold the highlighted text, and the Document menu will open. 

Searching in documents
You can search for occurrences of a word, phrase, letter or part of a word, characters and 
text symbols (for example, $, @) or numbers in a document by using the Find command. 

To search a document:

1   Tap the Menu icon on your handheld device (not in the display screen), and then tap 
Find in the Document menu. 

2   Enter the search string by writing in the Graffiti area or using the on-screen keyboard.

 You can search backwards by giving a reverse page range (for example 20 to 10), and 
you can search strings between paragraphs by inserting a space. 

3   Select any of the following search options:

•  From Current Pg. to search from the current page to the end of the document, and then 
through to the current page.

•  From Beginning to search the entire document from the first page.

•  From Page __ to __ to specify a page range for the search.

•  Exact Match to return results that match the whole word. 

•  Case Sensitive to return results that match the case of the search string.

4   Tap OK. 

Adobe Reader for Palm OS displays a progress dialog box as it searches. When it finds the 
search string, it displays the page and highlights the results. 

5   Do one of the following:

•  Tap the X in the corner of the search results dialog box to end the search and remain at 
the page with the last found result highlighted.

•  Tap Find Prev, or press the jog dial and scroll up to search for a previous occurrence.

•  Tap Find Next, or press the jog dial and scroll down to search for the next occurrence.

•  Tap New Find, or click the jog dial to begin a new search.



Using the table of contents
If the document author used Adobe Acrobat and created bookmarks, they become a table 
of contents when you transfer the PDF file to your Palm OS device. The Table of Contents 
lets you see the structure of the document and navigate it.

To open the table of contents:

Do one of the following:

•  Tap the Table of Contents icon .

•  Tap the Menu icon on your handheld device (not in the display screen), and then tap 
Show Table of Contents in the Document menu. 

To close the table of contents:

Tap Done.

To navigate using the table of contents:

Do one of the following:

•  Tap the entry.

•  If your handheld device has a jog dial, use the jog dial to select an entry, and then click 
to open it.

You may have to use the scroll bars to view all of the entries. Some entries may have 
subentries. These entries are marked with a plus icon (+). Tap the plus icon (+) to expand 
the entry and see all of its subentries.

Note: If no bookmarks exist in the PDF document, No Table of Contents string will be 
displayed in the Navigation pane.

Viewing comments
Comments are annotations created in Adobe Acrobat and attached to pages in a PDF file. 
You can use the Scan for All Comments command to collect and display all the comments 
together. The comments appear in the Comments view. To see all the comments, you must 
use the Scan for All Comments command each time you open the file.

If there are comments on the current page, the Table of Contents icon changes to .

To scan a document and collect all Comments:

Tap the Menu icon on your handheld device (not in the display screen), and then tap Scan 
for All Comments in the Document menu. Comments related to the current page appear 
in boldface.

To view the contents of a comment:

1   Do one of the following:

•  Tap the Menu icon on your handheld device (not in the display screen), and then tap 
Show Comments.

•  Tap the Table of Contents icon .

2   Select a comment, and do one of the following:



•  Tap Details to view its contents. You can then choose to go to the page containing the 
comment or close the comment.

•  Tap Go to Page to open the page containing the comment.

•  If your handheld device has a jog dial, press and hold the jog dial to open the page 
containing the comment.

To toggle between the Table of Contents and Comments views:

Do one of the following:

•  Tap the Table of Contents icon , and then tap the Table of Contents or Comments 
triangle.

•  Tap the Menu icon on your handheld device (not in the display screen), and then tap 
the view in the Document menu.

Beaming a file
You can beam a PDF file from your Palm OS device to another device. When you beam a 
file, the receiving device starts Adobe Reader and displays the document. You can beam 
only one file at a time. See your handheld documentation for additional beaming infor-
mation.

To beam a file:

Do one of the following:

•  From the File List view, select the name of the file, and tap Beam.

•  From within the open document view, tap the Menu icon on your handheld device (not 
in the display screen), and then tap Beam in the Document menu.

Printing over the Internet
You can send open Adobe PDF documents from your Palm OS device to printers and fax 
machines in the PrintMe network using the third-party plug-in, PrintMe Internet Printing. 
If you are near a PrintMe device, you can beam a document to the device for printing. (See 
“Beaming a file” on page 12.) For additional information about the PrintMe network and 
system requirements, please refer to the PrintMe Web site.

To print over the Internet:

1   Tap the Menu icon on your handheld device (not in the display screen), and then tap 
PrintMe in the Document menu. 

2   In the PrintMe to dialog box, enter your PrintMe ID. If you don’t have a PrintMe ID, 
choose File > PrintMe Internet Printing in Acrobat 6.0 or Adobe Reader 6.0 to sign up for a 
PrintMe user account. If you need assistance, click Help in the PrintMe Networks dialog 
box.

3   Click PrintMe.



Viewing document information
The Document Info dialog box provides the name, title, subject, author, and total pages. It 
also displays attributes set by Acrobat, PDFWriter, PDFMaker, or Acrobat Distiller®.

To view document information:

1   Do one of the following:

•  In the file list, tap the file size.

•  If the document is open, tap the Menu icon (not in the display screen), and then tap 
Document Info.

Note: To access the eBook-only document information, tap the triangle next to Standard 
at the bottom of the screen.

2   Tap Done to close the Document Info dialog box.

Viewing eBooks
Adobe eBook PDF files (eBooks) are PDF files that have been packaged by the Adobe 
Content Server to protect the copyright of the author or publisher. As with any Adobe PDF 
file, you can read eBooks on your Palm OS device. You can use My Bookshelf in Adobe 
Acrobat 6.0 to access and manage your eBooks. For more information about working with 
eBooks, see the Acrobat 6.0 Help.

eBooks are typically bought from online bookstores, borrowed from online lenders, or 
exchanged among users. To read an eBook, you must have a license to open and read the 
eBook (generally provided by the seller or lender) and activate Acrobat or Adobe Reader 
as an eBook Reader.

Activating your eBooks account
Before you can purchase or read eBooks, you must create an eBooks account by creating 
an Adobe DRM Activator account. You must also activate your Palm OS device as an eBook 
Reader. 

If you did not create an eBooks account when you first installed Acrobat or Adobe Reader, 
you are prompted to do so the first time you attempt to download, read, or send an eBook 
to your handheld device, or access the Adobe DRM Activator Web site.

To create an eBooks account and activate a Palm OS device:

1   On your desktop computer, connect to the Internet.

2   Go to the Adobe DRM Activator Web site:

•  In Adobe Reader, choose Tools  > eBook Web Services > Adobe DRM Activator.

•  In Acrobat, choose Advanced > eBook Web Services > Adobe DRM Activator.

3   Click Yes to start your browser and connect to the Adobe DRM Activator Web site.

4   Click the Activate Palm OS Device button .

Note: To activate the eBooks Reader software, you need your Adobe ID and password or 
your Microsoft .Net Passport ID and password. If you are a new user, follow the on-screen 
prompts to create an ID and password.



Downloading eBooks
After you have created an eBook account, you can download eBooks.

To download eBooks:

1   On your desktop computer, connect to the Internet.

2   In Acrobat or Adobe Reader, do one of the following:

•  On the toolbar, choose eBooks  > Get eBooks Online.

•  Choose File > My Bookshelf, and then click the eBooks Online button .

•  Choose Tools > eBook Web Services > Adobe eBook Central (Adobe Reader), or 
Advanced > eBook Web Services > Adobe eBook Central (Acrobat) and then navigate to 
the Adobe eBook Mall.

3   From the Adobe eBook Mall Web page, follow the on-screen prompts to buy or borrow 
eBooks.

Note: If you are browsing eBook Web sites and do not have Acrobat or Adobe Reader open, 
Acrobat or Adobe Reader automatically starts when you download an eBook.

4   If you download only one eBook, you are asked if you want to read the document 
immediately. Click Cancel to close the dialog box and open My Bookshelf. (See “Using My 
Bookshelf” in the Acrobat or Adobe Reader Help.)

Sending an eBook to your Palm OS device
Sending an eBook to a Palm OS device is very much like sending any Adobe PDF file to a 
handheld device.

Note: You cannot beam eBooks to other devices.

To send an eBook to a Palm OS device:

1   On your desktop computer, do one of the following:

•  On the Acrobat or Adobe Reader toolbar, choose eBooks  > My Bookshelf.

•  Choose File > My Bookshelf.

2   Select the eBook that you want to transfer to your handheld device, and then click Send 
to Mobile Device.

3   Click Prepare to Optimize the eBook for Reading on Adobe Reader for Palm OS and add 
it to the transfer list. The next time you perform a HotSync operation, the eBook is trans-
ferred to your handheld device.

The specific procedures for sending an eBook to handheld device depend on the type of 
Palm OS device that you have installed.

Note: Non-DRM PDF documents cannot be sent to a Palm OS device from My Bookshelf if 
they have permission settings or require a master password.



Viewing Adobe Photoshop® Album slideshows
Adobe Reader for Palm OS supports Adobe Photoshop Album slideshows. When you open 
an Adobe PDF file created from a Photoshop Album slideshow, Adobe Reader for Palm OS 
automatically plays the slideshow. 

To play a Photoshop Album slideshow:

Tap the filename of the Photoshop Album PDF file in the file list view.

To stop a Photoshop Album slideshow:

Tap the Menu icon on your handheld device (not in the display screen), and then tap Stop 
in the Slideshow menu. 

To replay a Photoshop Album slideshow:

Tap the Menu icon on your handheld device (not in the display screen), and then tap Play, 
or Rewind and Play in the Slideshow menu.



Using Shortcuts

Palm OS shortcuts
In addition to the standard shortcuts, there are others that help you navigate quickly by 
simply writing the Graffiti character that corresponds to the letters below. The shortcuts 
are not case sensitive, and you don’t have to enter the command stroke. Just enter the 
shortcut directly.

Document

Viewing

Result Graffiti character

Open o

Show Table of Contents t

Find f

Copy c

Beam b

PrintMe p

Document Info i

Result Graffiti character

Full Screen e

Hide Images m (a second m shows images)

Backward in History j or backspace

Forward in History l or space

Go to Page a

Go to Specific Page enter Page Number

Next Page numeric space

Previous Page numeric backspace

Preferences r



File list

Result Graffiti character

Sort File List by Name n (a second n inverts the list)

Sort File List by File Size z (a second z inverts the list)



Legal Notices

Copyright
Copyright © 2003 Adobe Systems Incorporated. All rights reserved.

Adobe® Reader® for Palm OS®, version 3.0

If this guide is distributed with software that includes an end user agreement, this guide, as well as the software described in it, is furnished 
under license and may be used or copied only in accordance with the terms of such license. Except as permitted by any such license, no part of 
this guide may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or 
otherwise, without the prior written permission of Adobe Systems Incorporated. Please note that the content in this guide is protected under 
copyright law even if it is not distributed with software that includes an end user license agreement. 

The content of this guide is furnished for informational use only, is subject to change without notice, and should not be construed as a 
commitment by Adobe Systems Incorporated. Adobe Systems Incorporated assumes no responsibility or liability for any errors or inaccuracies 
that may appear in the informational content contained in this guide.

Please remember that existing artwork or images that you may want to include in your project may be protected under copyright law. The 
unauthorized incorporation of such material into your new work could be a violation of the rights of the copyright owner. Please be sure to 
obtain any permission required from the copyright owner.

Any references to company names in sample templates are for demonstration purposes only and are not intended to refer to any actual 
organization.

Adobe, the Adobe logo, Acrobat, Distiller, Photoshop, and Reader are either registered trademarks or trademarks of Adobe Systems Incorpo-
rated in the United States and/or other countries. Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corpo-
ration in the United States and/or other countries. Palm OS is a registered trademark of Palm, Inc. All other trademarks are the property of their 
respective owners.

Portions of Adobe Acrobat include technology used under license of Verity, Inc. and are copyrighted.

Contains an implementation of the LZW algorithm licensed under U.S. Patent 4,558,302.

Adobe Systems Incorporated, 345 Park Avenue, San Jose, California 95110, USA.

Notice to U.S. Government End Users. The Software and Documentation are “Commercial Items,” as that term is defined at 48 C.F.R. §2.101, 
consisting of “Commercial Computer Software” and “Commercial Computer Software Documentation,” as such terms are used in 48 C.F.R. 
§12.212 or 48 C.F.R. §227.7202, as applicable. Consistent with 48 C.F.R. §12.212 or 48 C.F.R. §§227.7202-1 through 227.7202-4, as applicable, the 
Commercial Computer Software and Commercial Computer Software Documentation are being licensed to U.S. Government end users (A) 
only as Commercial Items and (B) with only those rights as are granted to all other end users pursuant to the terms and conditions set forth 
herein. Unpublished rights reserved under the copyright laws of the United States. Adobe Systems Incorporated, 345 Park Avenue, San Jose 
California 95110-2704, USA. For U.S. Government End Users, Adobe agrees to comply with all applicable equal opportunity laws including, if 
appropriate, the provisions of Executive Order 11246, as amended, Section 402 of the Vietnam Era Veterans Readjustment Assistance Act of 
1974 (38 USC 4212), and Section 503 of the Rehabilitation Act of 1973, as amended, and the regulations at 41 CFR Parts 60-1 through 60-60, 60-
250, and 60-741. The affirmative action clause and regulations contained in the preceding sentence shall be incorporated by reference.
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